IMPORTANT: This document provides a cumulative list of fixes for the Media Composer v2018.x releases. To see detailed information on each release, see the individual ReadMe for each release here.

Fixed in Media Composer v2018.12.1

The following have been fixed:

➤ **Bug Number:** MCCET-2809. You might have received a “DATAMOD_CONSISTENCY_CHECK” error when importing a .scc file.

➤ **Bug Number:** MCCET-2739. In some instances, the Blur effect was not properly applied to an image.

➤ **Bug Number:** MCCET-2790. The import Media Creation settings were not applied to the first import after launching the editing application.

➤ **Bug Number:** MCCET-2797. If you were working on a two monitor system, newly created bins are automatically displayed on the right monitor when previously they were displayed on the left monitor.

➤ **Bug Number:** MCCET-2791. Mask Margins were not showing up on exported graphic files.

➤ **Bug Number:** MCCET-2760. After performing a video mixdown the metadata on the Avid MediaFiles MXF files might be incorrect.

➤ **Bug Number:** MCCET-2595. When working on a system with a HiDPI monitor, you might have seen slow response when lassoing clips in the Timeline.

➤ **Bug Number:** MCCET-2787. On some Mac systems, the editing application would not launch if some fonts were disabled.

➤ **Bug Number:** MCCET-2732. When you consolidated AVC Long GOP G25 subclips, new master clips were created that were too long.
➤ Bug Number: MCCET-2794. You might have received an “Audio consumer duration differs from video edit” error when playing back a sequence containing a dissolve.

Fixed in Media Composer v2018.12

The following have been fixed:

➤ Bug Number: MCCET-2734. You could not perform a perf slip on subclips that were exported and then imported via AAF.

➤ Bug Number: MCCET-2741. When loading a sequence from the Interplay Window into the Source Monitor, some master clips appeared offline.

➤ Bug Number: MCCET-2752. (Mac Only) In some instances, after using the Source Browser, the “Recovered Files” folder with AAF files appeared in the Trash.

➤ Bug Number: MCCET-2413. Linked .mp4 clips had a 1-frame Timecode difference on audio and video when linked with the Avid Generic Plug-in.

➤ Bug Number: MCCET-2235. In an Interplay environment, you might have received an AAFProcessor error when linking to GoPro and XAVC-S media using the Avid Generic Plug-in.

➤ Bug Number: MCCET-2652. The color coding equation for a 2020 color space, might have appeared as 709 in the SMPTE Metadata Register.

➤ Bug Number: MCCET-2658. In some instances, animating a Circle Blur Effect on an imported still image as XDCAM, created an unexpected result.

➤ Bug Number: MCCET-2663. When working with Open IO_NDI, output only played the number frames set in the Desktop Play Delay setting.

➤ Bug Number: MCCET-2644. In some instances, you might have received an Exception error when exporting a sequence that contains an audio track effect with a long delay such as iZotope RX6 De-clip.

➤ Bug Number: MCCET-2673. Linking XAVC-S with the Avid Generic plug-in provided incorrect Timecode.

➤ Bug Number: MCCET-2754. When a locked bin was open in a project, the 3rd party product Baselight might have been unresponsive.
➤ **Bug Number:** MCCET-2674. The editing application was sluggish when working in Small Trim Mode.

➤ **Bug Number:** MCCET-2742. In some instances, Dynamic Relink settings were not retained in new projects if they were saved as a Site Setting.

➤ **Bug Number:** MCCET-2635. In some instances, an auto-save did not occur after adding or removing markers, or deleting clips and sequences.

➤ **Bug Number:** MCCET-2395. When applying a SPACE effect, and using a SPACE Impulse Response, render results were inconsistent.

➤ **Bug Number:** MCCET-2539. (Avid Artist DNxIV, Avid Artist DNxIP, AJA IO devices) In some instances, the position indicator jumped ahead when pressing play.

➤ **Bug Number:** MCCET-2740. Media Creation settings reverted back to previous setting if Drive Filtering settings were changed.

➤ **Bug Number:** MCCET-2727. When performing an Insert Edit Export, you could not select another target drive in the Look In menu in the Select Insert Edit Target window.

➤ **Bug Number:** MCCET-2697. In some instances, FrameFlex reformat parameter did not stick to AutoSynced clips.

➤ **Bug Number:** MCCET-2733. In some instances, fast import of AVC-Long G25 files would hang the editing application.

➤ **Bug Number:** MCCET-2602. With attached Avid Artist DNxIV, Avid Artist DNxIP, and AJA IO devices, playback started with a stutter on a Broadcast Monitor.

### Fixed in Media Composer v2018.11

The following have been fixed:

➤ **Bug Number:** MCCET-2695. Intermittently, you might have received an “Exception: QualityManager” errors when dragging certain clips to a bin. And certain clips would not load when double clicking or dragging from the Interplay window.

➤ **Bug Number:** MCCET-2642. You could not perform an Undo operation after performing a Send to Playback.
➤ **Bug Number:** MCCET-2719. Creating a “Bin based on Folder” when performing a link was not working correctly.

➤ **Bug Number:** MCCET-2715. Audio might not have played correctly when linking back an AMA File export of XDCAM 50 using the Avid Media Processor plug-in.

➤ **Bug Number:** MCCET-2722. In some instances, the editing application would crash if you were trimming with the mouse and Caps Lock was enabled.

➤ **Bug Number:** MCCET-2725. Trying to link to P2 resulted in a “Cannot open bin, please choose bin” dialog showing an empty Select dialog window.

➤ **Bug Number:** MCCET-2706. You might have received a “PMM_INSUFFICIENT_MEDIA” error if you changed the playback rate in the Source Settings.

➤ **Bug Number:** MCCET-2386. In some instances, a sequence with linked media could not be sent to playback.

➤ **Bug Number:** MCCET-2478. If you opened the Interplay Folder setting window, the previously entered “Interplay Root Folder for this Project” setting was lost.

➤ **Bug Number:** MCCET-2703. Subclip exports using the Avid Media Processor might have had wrong Timecode.

➤ **Bug Number:** MCCET-2675. If “All Markers at End” in the List options was enabled, saving an EDL to several files crashed the editing application.

➤ **Bug Number:** MCCET-2686. The editing application might have force quit when scrubbing a DNxHR HQX sequence.

➤ **Bug Number:** MCCET-2591. Audio might not have played back if you were in Trim mode and “Pitch Correction during Shuttle” was enabled in the Audio Settings.

➤ **Bug Number:** MCCET-2473. You might have received an “Exception: Failed to get the sample temporal 0ffset from the AMA Plug-in” error when exporting an XDCAM OP1a file. Get the latest XDCAM plugin from the nablet website to fix this issue. See [avid.com/ama](http://avid.com/ama).

➤ **Bug Number:** MCCET-2712. In some instances, Exporting AIFF-C or QuickTime Ref with AIFF-C crashed Media Composer with an “ACCESS_VIOLATION” error.

➤ **Bug Number:** MCCET-2692. Adding filler at the start did not position the section marked IN-OUT correctly.
➤ **Bug Number:** MCCET-2617. Intermittently, Group clips displayed in green, in the Source Monitor (Quad split or Nine split).

➤ **Bug Number:** MCCET-2663. You might have received an “Exception: QualityManagerImpl::relinkMaster” error when loading certain clips into a bin.

**Fixed in Media Composer v2018.10**

The following have been fixed:

➤ **Bug Number:** MCCET-2625. If OP1a XAVC VBR C300 UHD MXF files were linked using the MSP MXF Plug-In, you might have seen playback stuttering and playback errors written to the Console window.

➤ **Bug Number:** MCCET-2605. You might have seen a BSOD (Windows crash) after launching the editing application in a Media Composer | Cloud VM environment.

➤ **Bug Number:** MCCET-2586. Performing a Shift + render In-to-Out behaved differently if you performed it a second time.

➤ **Bug Number:** MCCET-2664. Exported audio set to Mono might have played back 3dB lower than the original sequence.

➤ **Bug Number:** MCCET-2691. (Windows 7) If you deselected “Re-encode for XDCAM” in the Transfer Settings, creating a new project with the same user would select the “Re-encode for XDCAM” option.

➤ **Bug Number:** MCCET-2694. When logged into Production Management Services, you might have received a “structured Exception” error when exiting the bin Fast Menu.

➤ **Bug Number:** MCCET-2672. In some instances, Media Creation settings did not remain the same after closing and opening the project.

➤ **Bug Number:** MCCET-2668. Send to Playback might have failed if your sequence contained audio with clip pan and a rendered audio dissolve.

➤ **Bug Number:** MCCET-2454. In some instances, transcoding 10bit to 8bit introduced vertical banding on solid color.

➤ **Bug Number:** MCCET-2292. Audio might have been out of sync and you might have seen audio underruns when linking Apple Prores 422 using the QuickTime plugin.
➤ **Bug Number:** MCCET-2619. When splitting a 5.1 audio track into mono tracks in the sequence the tracks were always arranged in the ProTools order, no matter what the Mix Mode Selection in the Audio Mixer was set to.

➤ **Bug Number:** MCCET-2638. The “NTSC Has Setup” option did not appear in the General Settings when a Nitris DX was connected.

➤ **Bug Number:** MCCET-2482. Exporting an H.264 sequence with stereo did not export as stereo.

➤ **Bug Number:** MCCET-2648. You might have received an “Exception: Tmf export only supports Long GOP” error when performing a Send To Playback with AVC Long GOP that has an I-frame at the beginning of the sequence.

➤ **Bug Number:** MCCET-2588. If your Tape ID contained spaces, the editing application would crash if you performed a Send To Playback.

➤ **Bug Number:** MCCET-2651. In some instances, a .transfer sequence with Long GOP format generated during the Send to Playback process, did not show as rendered.

➤ **Bug Number:** MCCET-2609. Performing an AMA File Export of MXF OP1a using Avid Media Processor set to Stereo Mix, exported as two separate mono tracks.

➤ **Bug Number:** MCCET-2639. If you closed and reopened a sequence multiple times, the Timewarp effect lost its render and the output setting changed to default (Interlaced).

➤ **Bug Number:** MCCET-2581. In some instances, you could not relink back to media that was linked with the Avid Generic plug-in.

➤ **Bug Number:** COGS-4963. (Live Timeline) In some instances, you could not scroll while performing playback in the Timeline.

➤ **Bug Number:** COGS-4939. (Live Timeline) You could not add markers on stereo audio in the Source Monitor during playback.

➤ **Bug Number:** COGS-4897. (Live Timeline) Loading a new clip into the Source Monitor by performing a drag and drop operation did not stop play and load the clip.

➤ **Bug Number:** COGS-4870. (Live Timeline) Pressing Ctrl + / did not zoom to show the entire sequence during playback.

➤ **Bug Number:** COGS-4862. (Live Timeline) When working in the Audio Mixer you could not enable/disable tracks during playback.
➤ **Bug Number:** COGS-4860. (Live Timeline) Clicking on Source Browser contents was stopping playback.

➤ **Bug Number:** MCCET-2599. The editing application became slow after loading a large sequence into the Source/Record monitor.

➤ **Bug Number:** MCCET-2601. The Trim to Fill (Timewarp) effect did not work on clips with a spatial adapter.

➤ **Bug Number:** MCCET-2646. You would receive an “Invalid File Name” error when transcoding a linked WAV file that contained two consecutive dots in the original file name.

➤ **Bug Number:** MCCET-2611. After sorting a bin by double clicking on a column, selecting an item in the bin resulted in the item being deselected.

➤ **Bug Number:** MCCET-2569. In some instances, the thumbnail displayed on the Frame column in the bin appear as Media Offline when importing a matte key.

➤ **Bug Number:** MCCET-2118. (Mac) Files that include “ ” in the name could not be transcoded and resulted in a “filed to import” error when checked out on a Windows system.

➤ **Bug Number:** MCCET-2590. When returning to the Find window to perform a repeat custom sift, the Custom Sift text field was not highlighted.

➤ **Bug Number:** MCCET-2653. You might have received a “Cannot be exported” error when performing an export to XDCAM OP1A of a “Capture in progress” clip.

➤ **Bug Number:** MCCET-2600. Airspeed MP2 low res proxy waveforms did not draw on the Timeline.

➤ **Bug Number:** MCCET-2254. A green/pink gradient might appear on some images captured from a Sony HDR FX1000E device.

➤ **Bug Number:** MCCET-2624. (Windows 10) You might have received a “FILE_OTHER” error when linking a P2 folder that contained a multibyte name on a shared workspace.

➤ **Bug Number:** MCCET-2520. If you had linked h.264 media containing AAC sound and then exported that media to h.264, the editing application would hang.

➤ **Bug Number:** MCCET-2627. (Mac) If you had Boris FX Final Effects Complete installed, you may have had problems with Open I/O devices.
Bug Number: MCDEV-9676. Intermittently, the blue bar in the Source and Record monitors did not move.

Bug Number: MCDEV-9781. You might have seen the following issues if Run Length Encoded is enabled:
- “Core Consistency Check Failure” errors when recreating animated Marquee titles
- Media size might not be accurate when working with interlaced projects

Bug Number: MCDEV-9523. When linking with the Avid Generic Plug-in, audio waveforms did not build properly in the Timeline when playing back an H.264 movie with AAC audio.

Fixed in Media Composer v2018.9

The following have been fixed:

Bug Number: MCCET-2626. The client monitor did not update properly if the Source/Record monitor was minimized.

Bug Number: MCCET-2629. When opening synced projects you might have received a “This bin has been deleted from Production Management” error.

Bug Number: MCCET-2620. In some instances, you could not link to short Sony XAVC-S files.

Bug Number: MCCET-2574. The AS-11 plug-in was updated to fix DPP UK Compliance errors.

Bug Number: MCCET-2573. Marker text was cut off in the Markers window.

Bug Number: MCCET-2606. An XML export in the List Tool generated bad timecode and frame counts for markers that were placed on clips with effects.

Bug Number: MCCET-2555. In some instances, LUTs were incorrectly applied on grouped clips after performing a transcode.

Bug Number: MCCET-2474. You might have seen a color shift on some systems with nVidia GTX 1070, 1080Ti cards. Make sure you have the latest Nvidia driver installed (v390.77).

Bug Number: MCCET-2587. (Mac) When exporting as Graphic, you received an error when trying to open the Format Options dialog.
Bug Number: MCCET-2509. (Mac) The editing application crashed when you switched between Full Screen Playback and an Internet browser window.

Bug Number: MCCET-2575. The editing application would quit unexpectedly if you performed an audio mixdown with more than 64 channels.

Bug Number: MCDEV-9629. Multiple Clip Info Settings appeared in the Project Window even if you had not created multiple settings.

Bug Number: MCDEV-9680. (List Tool) In some instances Cut lists added filler to the end of the sequence.

Bug Number: MCCET-2282. In some instances, lassoing was not visible when dragging the mouse using Selection tool.

Bug Number: MCCET-2465. You might have received an “CM_INVALID_SPLIT” error when trimming promoted motion clips.

Bug Number: MCCET-2466. The project name, sequence name, and date of printout was missing in the header of the marker printout.

Bug Number: MCCET-2498. In some instances, the editing application would crash if all bins were closed and the Capture Tool was open.

Bug Number: MCCET-2533. Intermittently, you might have received an “Exception Failed to find coincidence point on tape” error when trying to capture or batch capture into Media Composer.

Bug Number: MCCET-2548. Finding a frame by entering timecode value in the Source monitor did not work when searching on an audio mixdown.

Bug Number: MCCET-2580. Activating Play Standby would start playing too fast if you had played the sequence at double speed prior to pressing Play Standby.

Bug Number: MCCET-2585. After installing the editing application and creating a new project, you might have received an “assertion” error when opening the Tool Palette on the Source/Record Monitor.

Bug Number: MCCET-2589. (Windows OS) When using a Japanese locale, the source clip name did not display in the Timecode Window.

Bug Number: MCCET-2596. Match-framing a Multigroup clip with Symphony Color Correction applied, would match frame to the group clip instead of the main Multigroup clip.
Fixed in Media Composer v2018.8

The following have been fixed:

➤ **Bug Number:** MCCET-2582. You might have received an “Avid editor stopped working” error when performing a send to playback with XDCAM media to Airspeed.

➤ **Bug Number:** MCCET-2324. In some instances, the results of Color Correction Auto Contrast on some low contrast clips was not accurate.

➤ **Bug Number:** MCCET-2563. Capturing AVC LongG media using the Capture tool created DNxHD 145 media.

➤ **Bug Number:** MCCET-2578. You might have received a “Exception: BeginWriting failed” error when exporting as Windows Media.

➤ **Bug Number:** MCCET-2565. You might have received an “Assertion failed” error when trying to link or import WAV files.

➤ **Bug Number:** MCCET-2572. You might have received a CORE_SEGMENT_NOT_FOUND error when enabling (video) Dupe Detection with “Show Effect Contents” enabled in the Timeline settings.

➤ **Bug Number:** MCCET-2561. When performing a File > Open Bin on a read only workspace, the bin did not display with a RED locked icon.

➤ **Bug Number:** MCCET-2513. (Mac) You might have received an “Exception: std::exception” error when transcoding spanned AVCHD clips.

➤ **Bug Number:** MCCET-2566. In some instances, you could not import .m2t (HDV) files.

➤ **Bug Number:** MCCET-2112. You might have received an “Assertion failed” error when linking to AVC Long GOP with the Avid Generic Plug-in.

➤ **Bug Number:** MCCET-2567. When in Segment mode, dragging clips in the Timeline might not redraw properly if the Audio Mixer tool was open.

➤ **Bug Number:** MCCET-2034. Linking to Panasonic GH5 media using the Avid Generic plug-in might have displayed incorrect duration and timecode.

➤ **Bug Number:** MCCET-2441. In some instances, the editing application would show 100% CPU usage and would lock or hang when linking to specific MP4 files.
➤ **Bug Number:** MCCET-2544. Markers did not always transfer between two systems when the same Script was opened on both systems.

➤ **Bug Number:** MCCET-2543. The image might have appeared flipped when you relinked to an exported Tiff file.

➤ **Bug Number:** MCCET-2507. You might have received an incorrect Disk full error message when transcoding multiple spanned AVCHD clips.

➤ **Bug Number:** MCCET-2551. (Audio Mixer) In some instances, while stopping play to add volume effect to a clip, the fader slider would jump back. This did not happen if you were in Narrow Mixer mode.

➤ **Bug Number:** MCCET-2276. The editing application was slow to respond when changing audio mixer levels.

➤ **Bug Number:** MCCET-2500. Markers added in the Timeline did not always appear in the Marker Window.

➤ **Bug Number:** MCCET-2494. In some instances, the editing application might have crashed to a BreakPad window if you played back using the spacebar after adding markers from the keyboard.

➤ **Bug Number:** MCCET-2532. In some instances, performing a Find did not find all clips and sequences, in all bins in the project.

➤ **Bug Number:** MCCET-2489. 1080 50p (50 timebase) media in a 50i project was shifted by one frame.

➤ **Bug Number:** MCCET-2028. In some instances, linked XAVC S media using the Avid Generic Plugin did not display Timecode in the Start column.

➤ **Bug Number:** MCCET-2341. The List Tool change log was not correct. Comparing the same sequence with itself showed changes.

➤ **Bug Number:** MCCET-2524. In some instances, the position indicator (blue bar) was not in sync with sound and picture when using 3rd party I/O devices.

---

**Fixed in Media Composer v2018.7.1**

The following has been fixed:
Bug Number: MCCET-2558. (Mac OS 10.13.4 and higher) In some instances, start of play would take approximately 10 seconds before playback began.

**Fixed in Media Composer v2018.7**

The following have been fixed:

Bug Number: MCCET-2448. In some instances, since the release of Media Composer v8.10, you might have had trouble logging into your Avid Interplay environment.

With this release, the option “Legacy Production Management Host” has been added to the MediaCentral Server setting dialog. When this option is enabled, the hostname in the setting and the login user interface will be treated as a classic Interplay engine, not a MediaCentral engine.

- Only check this option if you are unable to login to your Interplay engine, and you **do not** have MediaCentral. If you have MediaCentral, you should login to the MediaCentral host.
- If you later upgrade to MediaCentral, you may still login to the Interplay engine with this checkbox enabled, but you will not see the MediaCentral Cloud UX panel. If you try to login to the MediaCentral engine with this checkbox enabled, you will receive an error. So, after upgrading to MediaCentral uncheck this checkbox, and login to the MediaCentral engine.

Bug Number: MCCET-2515. If you performed an AMA File export of video only sequences of Sony XAVC Intra 4K with the “Sony XAVC Intra 4K constraint” enabled, Avid Media Processor plug-in stops with an exception error message.

Bug Number: MCCET-2167. Performing a background transcode of XAVC-S media might have resulted in an Exception error.

Bug Number: MCCET-2147. The border of the 3D Warp effect exceeded the IRE range (100/0). A new option “Limit to video levels” has been added to the border options in the 3D Warp effect. Select this option to ensure the effect does not exceed the IRE range.

Bug Number: MCCET-2491. AS-11 exported from Media Composer included incorrect “Total Programme duration” metadata.

Bug Number: MCCET-2137. In some instances, the timecode of the LTC output was shifted by 1-2 frames when playing the Timeline.

Bug Number: MCCET-2358. You might have received a “SFPlayconsumer Execute Timeout” error when advancing through an Edit While Capture clip.
Bug Number: MCCET-2383. (Mac) In some instances, when opening a bin, a Breakpad window would open and after choosing an option, the editing application would crash.

Bug Number: MCCET-2516. Linking to a Vantage captured clip resulted in an error.

Bug Number: MCCET-2521. You could not successfully apply a Trim to Fill Timewarp effect on clips that had a spatial adapter (Frameflex).

Bug Number: MCCET-2484. If the Frame Column was selected in the Marker Window, choosing to Print all Markers would not print all markers.

Bug Number: MCCET-2411. The bin position moved after closing and then reopening the bin.

Bug Number: MCCET-2207. The editing application would not save Dynamic Relink settings if the target resolution was set to AVC Long GOP.

Bug Number: MCCET-2357. (Mac) Not all bins were indexed when you performed a search in the Find window.

Bug Number: MCCET-2463. (Mac) Duplicate AMALogger files might have appeared in a User folder.

Bug Number: MCCET-2502. A green status was incorrectly displayed after a failed login to MediaCentral.

Bug Number: MCCET-2432. When working with the SpectraMatte effect, the fixed Aspect check box did not function for the Scaling parameter.

Bug Number: MCCET-2483. You could not choose the “Optimize EDL” option if your sequence had four or more audio tracks.

Bug Number: MCCET-2487. Display Handles were not saved in the List tool.

Bug Number: MCCET-2453. You might have received an “Exception WM_SetinputProps_FAILED” error when exporting to Windows Media 5.1.

Bug Number: MCCET-2479. The Audio Punch-In Tool was not responding to keyboard input.

Bug Number: MCCET-2460. Dupe Detection was not visible in the Timeline when you toggled to the Source Monitor.
Bug Number: MCCET-2381. When using a Nitris DX, if you set 3.1 and 4.0 output settings in the Audio Project Settings, the settings changed back to stereo once you opened and closed the project.

Fixed in Media Composer v2018.5.1

The following have been fixed:

Bug Number: MCCET-2472. In some instances, you might have received a “FatalExcept Exception: std::exception” error when double-clicking the Dynamic Relink Settings.

Bug Number: MCCET-2476. Changing clip metadata in a Synced project might have resulted in an access violation.

Bug Number: MCCET-2336. In some instances, XDCAM HD 35 media displayed as if it had 12:9 aspect ratio in a 1920x1080 project format.

Bug Number: MCCET-2369. You could not navigate inside shared network shortcut folders from the Source Browser.

Bug Number: MCCET-2401. The center duration display was incorrect for UHD 50P projects with a 25 edit timebase.

Bug Number: MCCET-2470. You might have received an “AMA_Exporter Failed to finish write volume” error when Exporting an AS02 bundle over 4.2GB in file size.

Bug Number: MCCET-2469. (Windows) You might have received an “Exception: Export Volume Dialog” error when clicking on the AS02 Volume Properties button.

Bug Number: MCCET-1995. When linking to clips within an AMA volume folder structure, the drive might have been grayed out in the Media Creation settings if you tried to link to any of the individual mxf files in the volume subfolder.

Bug Number: MCCET-2389. The Black Marker appeared as gray in the Command Palette More tab. The Black Marker now appears as black in the Command Palette. If your User Interface is set to a darker interface, the Black Marker icon appears with a white border in the Command Palette.

Bug Number: MCCET-2441. The editing application would hang when linking to some MP4 media.
➤ **Bug Number: MCCET-2475.** Intermittently, the editing application would crash when you were quickly editing, trimming, slipping, and selecting trim points.

➤ **Bug Number: MCCET-2380.** Once you closed out the Color Correction window and opened it again to make changes; the changes did not apply.

➤ **Bug Number: MCCET-2419.** All duplicate frames from the same master clip had the same color, regardless of them being the same frame or not.

➤ **Bug Number: MCCET-2448.** In some instances, since the release of Media Composer v8.10, you might have had trouble logging into your Avid Interplay environment.

With this release, the option “Legacy Production Management Host” has been added to the MediaCentral Server setting dialog. When this option is enabled, the hostname in the setting and the login user interface will be treated as a classic Interplay engine, not a MediaCentral engine.

- Only check this option if you are unable to login to your Interplay engine, and you **do not** have MediaCentral. If you have MediaCentral, you should login to the MediaCentral host.
- If you later upgrade to MediaCentral, you may still login to the Interplay engine with this checkbox enabled, but you will not see the MediaCentral Cloud UX panel. If you try to login to the MediaCentral engine with this checkbox enabled, you will receive an error. So, after upgrading to MediaCentral uncheck this checkbox, and login to the MediaCentral engine.

➤ **Bug Number: MCCET-2360.** Using the Ctrl key with the splice-in button on the Smart Tool to drag and drop from the Source monitor to the Timeline did not snap correctly unless Wireframe Dragging was enabled in the Timeline Settings.

➤ **Bug Number: MCCET-2359.** The lasso did not consistently appear when using Ctrl+M and Ctrl+J to zoom in and out in the Timeline.

➤ **Bug Number: MCCET-2423.** In some instances, you received errors when trying to import some Canon XC15 media files.

➤ **Bug Number: MCCET-2417.** In some instances, even when the “Copy Source Markers” option was deselected in the Composer Settings Edit tab, markers were included when you dropped the source clip into the Timeline.

➤ **Bug Number: MCDEV-9138.** You could not open multiple bins at the same time from the Finder/Desktop.

➤ **Bug Number: MCCET-2378.** You might have seen artifacts when playing back linked Sony AVC-Intra MXF media.
Bug Number: DAMAN-2530. A transcode message was outdated. In previous releases, a transcode message indicated you could not relink to transcoded clips. Relink is supported when you are linking to like frame rates, for example: 23, 29, 59 are like frame rates, 25 and 50 are like frame rates, and 24, 30 and 60 are like frame rates.

- Re-linkable NTSC formats/frame rates (regardless of raster):
  - 23.976p, 29.97p, 59.94i, 59.94p
  - 24p, 30i, 30p, 60p

- Re-linkable PAL formats (regardless of raster):
  - 25i, 25p, 50i, 50p

The new transcode message correctly indicates you cannot batch capture or batch import the new transcoded clips.

Fixed in Media Composer v2018.5

The following have been fixed:

- Bug Number: MCCET-2437. AMA Export File Insert Edit did not work unless you selected all tracks in the sequence or clip.

- Bug Number: MCCET-2211. In some instances, you might have heard audio corruption on XDCAM linked media.

- Bug Number: MCCET-2362. (Interplay) Sometimes Color Correction presets were inadvertently checked in.

- Bug Number: MCCET-2431. If you performed a Clear Bin Memory, the Color Correction Presets category no longer appeared in the Effect Palette.
➤ **Bug Number:** MCCET-2354. In some instances, after rendering a Compressor/Limiter effect, some of the audio no longer plays.

➤ **Bug Number:** MCCET-2345. If you mapped the “To the right” button from the Command Palette Edit tab to the keyboard, that mapped button did not behave the same as choosing Select > To the right from the Timeline context menu.

➤ **Bug Number:** MCCET-2364. After relaunching the editing application, the Audio Suite render Drive defaulted to C drive regardless of Media Creation Settings.

➤ **Bug Number:** MCCET-2402. In some instances, an MXF OP-atom file displayed as a linked video file when it was actually an imported file. Selecting the file might have resulted in an Exception error.

➤ **Bug Number:** MCCET-2421. In some instances, the editing application would crash if you exported AAF Embedded Audio-only AIFF-C media.

➤ **Bug Number:** MCCET-2399. The file extension did not always change when you modified Export settings.

➤ **Bug Number:** MCCET-2248. Occasionally, you might have seen playback jitter when creating XDCAM HD 50 media.

➤ **Bug Number:** MCCET-2429. After clearing the Source monitor, marker comments might have been missing from the Source monitor on audio only clips.

➤ **Bug Number:** MCCET-2394. In some instances, a crash report window would display after you opened the Media Creations Settings.

➤ **Bug Number:** MCCET-2349. In some instances, synced clips were corrupted when audio was relinked.

➤ **Bug Number:** MCCET-2398. When working with the Timecode Burn-In effect, you could not select tracks higher than 24.

➤ **Bug Number:** MCCET-2348. (Avid DNxIO) In some instances, Audio meters did not work when scrubbing with Caps Lock on.

➤ **Bug Number:** MCCET-2032, DMAN-2217. A Chroma Sub Sampling column has been added that will display the sub sampling rate for media.

➤ **Bug Number:** MCCET-2420. SDI Embedded DVITC output stopped when you opened the Audio Mixer Tool.
Bug Number: MCCET-2396. In some instances, the Reduce/Enlarge buttons did not work properly in the Effect Editor.

Bug Number: MCCET-2434. The Marker window did not display correctly after you printed markers.

Bug Number: MCCET-2436. The Marker window did not always display the correct markers from the selected Source/Record window. For example, even if you selected the Source window, the Marker window displayed the Record markers.

Bug Number: MCCET-2352. In some instances, after transcoding a clip, the ARRI LUT was not applied correctly.

Bug Number: MCDEV-8300. After performing a mixdown, the target bin you selected in the Video Mixdown window was no longer selected when you returned again to the Video Mixdown window.

Bug Number: MCDEV-9105. In some instances, even when Show Tooltips was deselected in the Interface settings, tooltips still appeared.

Bug Number: MCDEV-9124, MCCET-2435. In some instances, clicking the Markers button at the bottom left of the create Marker window, opened an old style version of the Marker Tool window.

Bug Number: MCDEV-9122. With the blue bar positioned over a marker in the active Composer monitor, opening the Marker Tool did not scroll to and highlight that marker's row.

Bug Number: MCCET-2200. Even after XDCAM clips were consolidated, they would relink back to the removal media drive once the removable drive was browsed again.

Bug Number: MCCET-2314. (Media Composer | Cloud) In some instances, the editing application crashed after a remote download finished when you relinked to the downloaded media.

Bug Number: MCCET-2372. When creating an XML output from the List Tool, the Marker data was incorrect for Opticals if you had effects on clips.

Bug Number: MCCET-2366. You might have received a “Standard Exception” error when transcoding linked AVCHD clips.

Bug Number: MCCET-2356. The Media Creation window did not remember the last tab selected.
➤ **Bug Number:** MCCET-2333. You might have seen artifacts on the first frame when linking AS-11 clips created by 3rd party application ContentAgent.

➤ **Bug Number:** MCCET-2340. Instead of a non descriptive error appearing, you will receive a “Warning: Some of the tracks are locked” when trying to edit into a locked track.

➤ **Bug Number:** MCCET-2346. The first result in the Find window was not automatically highlighted.

➤ **Bug Number:** MCCET-2376. (Mac) The editing application exited from Full Screen Play when you saved changes.

➤ **Bug Number:** MCCET-2385. In some instances, after using some keyboard shortcuts, there would be incorrect focus to the Source/Record monitors.

➤ **Bug Number:** MCCET-2406. Focus in the User Interface was not correct after entering a comment on a marker and then exiting the Marker Window with the Enter key on the numeric keypad.

➤ **Bug Number:** MCCET-2252. With the release of Mac OS v10.13.x (High Sierra), Media Composer could not write (i.e. capture, import, render) to the system drive.

**Fixed in Media Composer v2018.4**

The following have been fixed:

➤ **Bug Number:** MCCET-2382. When logged into the MediaCentral server, you might have received an “Unable to start the job” error when performing a Transcode in Media Composer.

➤ **Bug Number:** MCCET-2371. A sequence did not get added to a bin when dragging from MediaCentral Web Interface to Media Composer.

➤ **Bug Number:** MCCET-2226. Switching cameras in the Source Monitor was not working consistently.

➤ **Bug Number:** MCCET-2332. In some instances, audio files linked with the WaveAiff plug-in may have come in with the wrong duration.

➤ **Bug Number:** MCCET-2347. You might have received a “Mac2QT” error when using a password protected screen saver.
Bug Number: MCCET-2365. Performing a Link to Volume export for an AS02 file in an Interplay environment, resulted in an “assertion failed” error.

Bug Number: MCCET-2331. You might have received an Exception error when double-clicking on a non-standard resolution Pro-res clip.

Bug Number: MCCET-2320. In some instances, the Script Bin did not get saved with Auto-save.

Bug Number: MCCET-2285. If Effects mode was enabled, adjusting frames using keypad did not display the text box with the entered numbers inside Source/Record window.

Bug Number: MCCET-2317. When importing monophonic files in the Source Browser, they imported as multiple master clips rather than one master clip.

Bug Number: MCCET-2320. The Audio time-code rate in the Link Settings Link Options did not work when using BWAV Files (BWF).

Bug Number: MCCET-2244. (Mac) The editing application would intermittently freeze when entering Trim mode.

Bug Number: MCCET-2338. When Dupe detection for video was activated, the same clips had different color even though they were duplicates.

Bug Number: MCCET-2231. Dupe detection was not working properly on clips that had Spatial adapters.

Bug Number: MCCET-2224. In some instances, you could not resize the Tool palette.

Bug Number: MCCET-2323. Audio files linked with the WaveAiff plug-in did not have the correct timecode.

Bug Number: MCCET-2326. Cyrillic characters displayed as ??? in the Timeline Clip Notes window.

Bug Number: MCCET-2361. (Mac) When in an Interplay environment, you might have experienced a crash when exiting the editing application.

Fixed in Media Composer v2018.3

The following have been fixed:
Bug Number: MCCET-2218. When working with the Subcap effect, the Arial Bold font characters looked different between Media Composer v8.5.3 and v8.9.4.

Bug Number: MCCET-2270. In-progress AVC-Intra clips were not updating properly in the editing application. For example, the Capture in Progress slide would appear in media that was known to be valid.

Bug Number: MCCET-2291. Significant WIFI speed dropped when Media Composer and/or Application Manager were running.

Bug Number: MCCET-2298. If you installed the third party Ross Video plug-in, it might not have been available in the Project Window Effect category list.

Bug Number: MCCET-2267. In some instances, enabling MultiCam was twice as slow than in previous releases.

Bug Number: MCCET-2266. In some instances, it took twice as long to load a sequence than in previous releases.

Bug Number: MCCET-2300. Match Frame was not working properly for audio on a group clip.

Bug Number: MCCET-2286. When working with 50p projects, the two-frame safety did not work when playing, pausing or performing an insert or overwrite edit.

Bug Number: MCCET-2216. In some instances, an AS-02 bundle export resulted in a blank volume bin and an “invalid bundle” message in Console Window.

Bug Number: MCCET-2097. Linking an MXF clip created from Resolve might have resulted in an “Exception: Cannot create the AMA sample mapper to play this clip” error.

Bug Number: MCCET-2021. If you were a non-administrator, when switching inputs on the Avid Artist DNxIO in the Video Desktop software, you would be prompted to enter an administrator password.

Bug Number: MCDEV-8884. (HP Z8 system) Previously, if you were working on an HP Z8 system with no connection to the serial port, Media Composer might hang during launch or when you selected a project. With this release, you might see a Timeout message that you can click OK and continue successfully. If the problem persists, you can either connect a device to the serial port, or disable the COM1 port in the Device Manager.

Bug Number: MCCET-2253. In some instances, closing the Marker edit pane and pressing Play resulted in a Breakpad window and a “Structured Exception” error.
Bug Number: MCCET-2294. When exporting DNxHR OP1a MXF, Start TC was shifted two frames on 59.94p Drop Frame timecode.

Bug Number: MCCET-2238. In some instances, when performing an Audio only capture, with “Enable edit to timeline” option selected in the Capture Settings, the editing application would crash.

Bug Number: MCCET-2186. The Avid Artist DNxIO settings window did not open from the Media Composer Tools > Hardware menu item or from the Hardware (gears) icon in the Capture Tool.

Bug Number: MCCET-2230. Thin raster presets have been included in the New Project window.

Bug Number: MCCET-2232. Exporting to XDCAM resulted in an “Exception” error if the sequence included a data track.

Bug Number: MCCET-2287. Saving the Composer windows size in a workspace was not retained when switching from Color Correction workspace to Source / Record workspace.

Bug Number: MCCET-2277. If you selected a Start TC or End TC column, you might have received an “Are you sure you want to change the starting Timecode” message even if you did not change the timecode.

Bug Number: MCCET-2289. (List Tool) The Save As location defaulted to the Avid Users directory even if the previous Save As was changed to a new location.

Bug Number: MCCET-2296. With this release, if you are exporting markers as text and if at least one of the marker comments contains a tab or return, you will now be prompted with the option to replace the tabs and returns with a single space.
Fixed in Media Composer v2018.2

The following have been fixed:

➤ **Bug Number:** MCCET-2251. (Windows 10) Background services were not working for Dynamic Media Folders.

➤ **Bug Number:** MCCET-2242. MXF OP1a XAVC 300 UHD media failed to play when linked with Source Browser.

➤ **Bug Number:** MCCET-2223. Syncing multiple clips changed the aspect ratio in the bin column from 16x9 to 4x3.

➤ **Bug Number:** MCCET-2280. When creating Site Settings, the setting for the Interplay Folder did not work.

➤ **Bug Number:** MCCET-2263. When exporting Same as Source AVCi/50 media, the image might have video artefacts and scrambled signals.

➤ **Bug Number:** MCCET-2261. The Production Management window was not available from the Tools menu until you logged in.

➤ **Bug Number:** MCCET-2246. You would lose full transparency after cropping an image with an Alpha channel.

➤ **Bug Number:** MCCET-2274. In some instances, entering values in the Effect Editor reset to 0.

**Bug Number:** MCCET-2194. In some instances, making audio adjustments did not affect rendered audio effects in the Timeline.

➤ **Bug Number:** MCCET-2234. Reverse Match Frame pointed to the incorrect frame when working with synced clips with different audio Pan.

➤ **Bug Number:** MCCET-2281. If you were working in an Interplay environment, Media Composer might have crashed when exiting the application.

➤ **Bug Number:** MCCET-2247. In some instances, the editing application would crash when importing AAF with embedded video and audio.
Bug Number: MCCET-2237. If you named a project folder with an invalid name (such as CLIP) you received an error you could not recover from unless you performed an end task. With this release, if you use an invalid name for a project folder, you will receive a message indicating the name is invalid and you will be able to rename the folder.

Bug Number: MCCET-2219. In some instances, the Media Composer would hang for approx 30 seconds on “Connecting to Media Indexer” in the Splash Screen.

Bug Number: MCCET-2245. When attached to a Nitris DX, rendering long (20 min.) stereo audio clips with AudioSuite effects would hang during the render process.

Bug Number: MCCET-2190. You might have seen a shift in volume/reverb effect when working with the Avid SPACE plug-in.

Bug Number: MCCET-2204. When working with the Media Composer | Cloud client, incorrect frames were displayed in the Source Monitor when scrubbing with Video Cache enabled.

Bug Number: MCCET-2101. (Mac) In some instances, you would see the spinning beach ball when editing with a sequence with many clips (+1000).

Bug Number: MCCET-2209. When performing a 1080p/30 AMA File Export to DPX, you might have received a “Selected compression format is unsupported” error message.

Bug Number: MCDEV-8627. When working with locales other than English, the title names of some Settings windows were not displayed correctly.

Bug Number: MCDEV-8809. You might have received an Assert error when working in the Marker Window with the Frame column enabled.

Bug Number: MCDEV-8817. Setting a specific bin view as the default view then opening a new bin did not use the default bin view.

Bug Number: MCCET-2210. Imported IMX50 media might have appeared vertically stretched when placed it on the Timeline.

Bug Number: MCDEV-8800. If you had enabled the “Skip prompts to save locked bins on Auto-save” in the Bin Settings window, you would get a warning the next time you opened the Bin Settings window.

Bug Number: MCDEV-8763. You might have received an erroneous “A minimum screen height of 768 is required” error when launching the editing application.
➤ **Bug Number:** MCDEV-6253. When in Text View, you might have seen black or transparency at the bottom of the bin when resizing the bin.

➤ **Bug Number:** MCDEV-8735. Grid Settings did not update when you clicked Apply.

➤ **Bug Number:** MCDEV-8682. In some instances using Ctrl +Z for Undo did not work properly when you were making changes in the Effect Editor window for some effects such as Boris Continuum Complete.

➤ **Bug Number:** MCCET-2236. The editing application might have crashed if you performed a Remove Match Frame Edit with the Marker window open.

➤ **Bug Number:** MCCET-2227. (Macintosh) Reveal File did not reveal all the files if the clip had more than 16 tracks.

➤ **Bug Number:** MCCET-2229. With Media Composer v8.9.3 and above, even when disconnected from Avid Interplay, when you selected and opened a project the Login pop-up was displayed.

➤ **Bug Number:** MCCET-2205. The import might have failed when batch re-importing a clip with a tape name.

---

**Fixed in Media Composer v2018.1**

The following have been fixed:

➤ **Bug Number:** MCDEV-8705. In the previous release, automatic color adapters were not applied for REC2020/HLG. With this release, the correct color transformations have been included.

In addition, a few minor name changes have been made to the Source Color Space Preset dropdown menu.

- Rec2020 (SMPTE 2084) has been renamed to Rec2020/PQ
- Rec 2020 (HLG) BT2100 has been renamed Rec2020/HLG

➤ **Bug Number:** MCCET-2228. In some instances, you could not drag sequences to the Source monitor from the Production Management Window.

➤ **Bug Number:** MCDEV-6253. (Mac) When in Bin Text View, you might have seen a horizontal row of black or artifacts in the bin when resizing bins.
➤ **Bug Number:** MCDEV-8604. In some instances bins appeared larger when you undocked them from a tabbed position.

➤ **Bug Number:** MCDEV-8407. When working in a Japanese OS, characters might have appeared corrupted in the Source Settings window.

➤ **Bug Number:** MCCET-2185. When in the Effect Editor, pressing the period key on the keyboard would reset the slider value to 0. This happens because the period key can be used to type in decimal point values to move sliders, or as a mapped keyboard command (Trim Right 1). If you want to use the period to enter a decimal point value, make sure to enter a numeric number before the period. For example, to move the slider .4, enter 0.4. If you press the period without first entering a number, the mapped keyboard command is implemented.
Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2018 Avid Technology, Inc. and its licensors. All rights reserved.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, iNEWS, ISIS, Mbox, MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and all related product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or other countries. The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility for Avid products. All other trademarks are the property of their respective owners. For a full list of Avid trademarks, see: http://www.avid.com/US/about-avid/legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.